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1 How to get Page Fault Monitor

Page Fault Monitor is free for commercial use. Page Fault Monitor can be downloaded for Software

Verify's website at https://www.softwareverify.com/product/page-fault-monitor/.

This help manual is available in Compiled HTML Help (Windows Help files), PDF, and online.

Windows Help https://www.softwareverify.com/documentation/chm/pageFaultMonitor.chm
PDF https://www.softwareverify.com/documentation/pdfs/pageFaultMonitor.pdf
Online https://www.softwareverify.com/documentation/html/pageFaultMonitor/index.html

Whilst Page Fault Monitor is free for commercial use, Page Fault Monitor is copyrighted software and is
not in the public domain. 

You are free to use the software at your own risk. 

You are not allowed to distribute the software in any form, or to sell the software, or to host the software
on a website.

Contact

Contact Software Verify at:

Software Verify Limited
Suffolk Business Park
Eldo House
Kempson Way
Bury Saint Edmunds
IP32 7AR
United Kingdom

email sales@softwareverify.com
web https://www.softwareverify.com
blog https://www.softwareverify.com/blog
twitter http://twitter.com/softwareverify

Visit our blog to read our articles on debugging techniques and tools.
Follow us on twitter to keep track of the latest software tools and updates.

https://www.softwareverify.com/product/page-fault-monitor/
https://www.softwareverify.com/documentation/chm/pageFaultMonitor.chm
https://www.softwareverify.com/documentation/pdfs/pageFaultMonitor.pdf
https://www.softwareverify.com/documentation/html/pageFaultMonitor/index.html
mailto:sales@softwareverify.com
https://www.softwareverify.com
https://www.softwareverify.com/blog
http://twitter.com/softwareverify


Part

II



What does Page Fault Monitor do? 5

Copyright © 2015-2026 Software Verify Limited

2 What does Page Fault Monitor do?

Page Fault Monitor allows you to view page fault data for a specific application in real time.

History

Page Fault Monitor has been an internal tool at Software Verify for many years. We recently decided to
make it a bit more user friendly and to make it available for public use.
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3 Menu

The main menu contains four menus, File, Edit, Software Updates and Help.

3.1 File

The File menu controls viewing of DLLs and program exit.

File menu  View DLLs  view information about the DLLs in the process.

File menu  Exit  closes Page Fault Monitor.

3.2 Launch

The Launch menu controls the monitoring of processes for Page Faults.

Launch menu  Start Application...  start an application and start monitoring it for page faults.

Launch menu  Re-Start Application  start the most recently started application and start
monitoring it for page faults.

Launch menu  Monitor a Process...  choose a process and start monitoring it for page faults.

Launch menu  Wait For Application...  wait for an application to start and start monitoring it for
page faults.

Launch menu  Stop Monitoring  stop monitoring a process for page faults.

3.3 Settings

The Settings menu controls editing settings.
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Settings menu  Edit Settings...  displays the settings dialog.

3.4 Software Updates

The Software Updates menu controls how often software updates are downloaded.

If you've been notified of a new software release to Page Fault Monitor or just want to see if there's a new
version, this feature makes it easy to update.

  Software Updates menu  Check for software updates   checks for updates and shows the
software update dialog if any exist 

An internet connection is needed to be able to make contact with our servers.

 Before updating the software, close the help manual, and end any active session by closing
target programs.

If no updates are available, you'll just see this message:

Software Update dialog

If a software update is available for Page Fault Monitor you'll see the software update dialog.
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· Download and install   downloads the update, showing progress 

Once the update has downloaded, Page Fault Monitor will close, run the installer, and restart.

You can stop the download at any time, if necessary.

· Don't download...  Doesn't download, but you'll be prompted for it again next time you start Page
Fault Monitor 

· Skip this version...  Doesn't download the update and doesn't bother you again until there's an
even newer update 

· Software update options...  edit the software update schedule 

Problems downloading or installing?

If for whatever reason, automatic download and installation fails to complete:

· Download the latest installer manually from the software verify website.  

Make some checks for possible scenarios where files may be locked by Page Fault Monitor as follows:

· Ensure Page Fault Monitor and its help manual is also closed

· Ensure any error dialogs from the previous installation are closed

You should now be ready to run the new version.

Software update schedule
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Page Fault Monitor can automatically check to see if a new version of Page Fault Monitor is available for
downloading.

  Software Updates menu  Configure software updates   shows the software update schedule
dialog

The update options are:

· never check for updates 
· check daily (the default)
· check weekly
· check monthly  

The most recent check for updates is shown at the bottom.

Software update directory

It’s important to be able to specify where software updates are downloaded to because of potential
security risks that may arise from allowing the TMP directory to be executable. For example, to
counteract security threats it's possible that account ownership permissions or antivirus software blocks
program execution directly from the TMP directory.

The TMP directory is the default location but if for whatever reason you're not comfortable with that, you
can specify your preferred download directory. This allows you to set permissions for TMP to deny
execute privileges if you wish.

  Software Updates menu  Set software update directory  shows the Software update
download directory dialog
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An invalid directory will show the path in red and will not be accepted until a valid folder is
entered.

Example reasons for invalid directories include:

· the directory doesn't exist 
· the directory doesn't have write privilege (update can't be downloaded)
· the directory doesn't have execute privilege (downloaded update can't be run)

 When modifying the download directory, you should ensure the directory will continue to be valid.
Updates may no longer occur if the download location is later invalidated.

· Reset   reverts the download location to the user's TMP directory 

The default location is c:\users\[username]\AppData\Local\Temp 

3.5 Help

The Help menu controls displaying this help document and displaying information about Page Fault
Monitor.

Help menu  About Page Fault Monitor...  displays information about Page Fault Monitor.

Help menu  Readme and Version History...  displays the readme and version history.
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Help menu  Help Topics...  displays this help file.

Help menu  Help PDF...  displays this help file in PDF format.

Help menu  Help on softwareverify.com...  display the Software Verify documentation web page
where you can view online documentation or download compiled HTML Help and PDF help documents.

Help menu  Blog...  display the Software Verify blog.

Help menu  Library...  display the Software Verify library - our best blog articles grouped by related
topics.

Help menu  Contact customer support...  displays the options for contacting customer support.

Click a link to contact customer support.

Help menu  How do I?...  displays the options for asking us how to do a particular task.

https://www.softwareverify.com/documentation/html/pageFaultMonitor/index.html
https://www.softwareverify.com/blog/
https://www.softwareverify.com/library/library/
https://www.softwareverify.com/library/library/
https://www.softwareverify.com/contact/
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4 The user Interface

The user interface of Page Fault Monitor is shown below.

The top list shows all unique addresses that caused page faults for the monitored process. 

The bottom list shows the page fault information associated with any address in the top list. Select an
address in the top list and the related data is shown below. 

For any addresses that we can determine the DLL, symbol, filename and line number, we display that
information in the source code window at the bottom of the display.

Above the top list various Virtual Memory status values are shown indicating virtual size, working set
size, page file usage and various quota values. The total page fault count for the application is also
shown, this value will be different from the number of page faults that Page Fault Monitor has information
about. The reason the two values are different is that Page Fault Monitor displays the information
Windows NT provides about page faults. Windows NT only stores a limited amount of data about page
faults. Once this storage is used up, no more data is stored until after Page Fault Monitor has asked for
the stored data. If Page Fault Monitor does not ask for the data frequently enough some information will
be discarded by Windows NT.

· Update Interval  changes how often information about page faults is queried. The shorter the
interval, the more accurate the information collected about page faults 

· No Update  choosing No Update in the combo prevents the page fault list from being
updated by the timer. When No Update is chosen, the Refresh button is enabled 

· Refresh  refreshes the processes list and the page fault list 

The picture shown below shows Page Fault monitor monitoring coverageValidator_x64.exe.
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This picture shows process 2808 (coverageValidator_x64.exe) is being monitored for page faults. Page
Fault Monitor has collected information about 572 page faults caused by coverageValidator_x64.exe. The
top list shows information about the page faults. The list displays the addresses of all instructions that
have caused page faults. The Fault Count column indicates how many times this address has caused a
page fault. The Fault Addresses column indicates how many different fault addresses are associated
with page faults at this instruction address.

When displaying information about instructions, Page Fault Monitor will try to display DLL name,
symbol, filename and line number, with the latter being taken from debug information. 

Selecting an address in the top list causes information about the page faults at that address to be shown
in the bottom list. The source code and symbol information (if known) is also displayed.

Note that the Page Fault count of 564,000 is higher than the numbers monitored by Page Fault Validator
because memoryValidator_x64.exe in this example has been running for a very long time, whereas Page
Fault Monitor has been running for a few minutes.
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5 Settings dialog

The settings dialog allows you to configure how Page Fault Monitor gets symbol information.

Symbol Search Paths

We use debug information found in PDB files to turn addresses into human readable symbols, filenames
and lines.

By default there is one path in the symbol search paths: c:\windows\symbols\dll.

If you wish to add more paths to symbols you can add or remove them using the Add..., Remove and
Remove All buttons.

You can restore the default symbol paths using the Set Default button.

Symbol Server

If the symbol server is enabled (Use Symbol Server) Page Fault Monitor will download symbols using a
symbol server.

Symbols are downloaded to a Symbol Directory. This directory must be valid for the symbol server to
work. You can type the directory name or click Browse... to use the Microsoft folder browser to select
the directory.

Microsoft DLLs
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For Microsoft DLLs that are found in the Windows System32 directory we download symbols from
Microsoft's symbol server: 

http://msdl.microsoft.com/download/symbols

None Microsoft DLLs

For none Microsoft DLLs we download symbols from the symbol server specified on the settings dialog in
the Symbol Server field. 

You can set the symbol server to it's default value using the Set Default button.

Please note that if you have symbol servers enabled there may be a delay in providing symbol
information the first symbols for a specific DLL are downloaded from the symbol server.

Reset

You can reset the settings to their default state at any time by clicking Reset.

5.1 Symbols

5.1.1 Symbol Servers

The Symbol Server settings allow you to specify what symbol servers to use.

 You do not need to specify a symbol server if you do not wish to. Page Fault Monitor will work
correctly without a symbol server. 
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Symbol server

The symbol server is entirely optional, but is useful for obtaining symbols from a centralized company
resource or for obtaining operating symbols from Microsoft.

The default symbol server is the Microsoft symbol server used for acquiring symbols about Microsoft's
operating system DLLs. You may also wish to add some symbol servers for any software builds in your
organisation.

A symbol server is defined by at least the following:

· the symbol server dll to be used to handle the symbol server interaction 
· a directory location where symbol definitions are saved
· the server location - a url

The symbol server can be enabled or disabled allowing you to keep multiple symbol server configurations
available without constantly editing their definitions. 

Symbol Server Errors

Any symbol server entry shown in red indicates there is a problem with parts of the definition of that
symbol server. 

In the image shown above the symbol server at http://127.0.0.42:8000 cannot be reached. It is either
offline or does not exist.

Managing symbol servers

· Add...  displays the symbol server dialog described below 

· Remove  remove selected symbol server(s) in the list

· Remove All  remove all symbol servers

· Enable All  enables all symbol servers in the list 

· Disable All  disables all symbol servers

You can also enable or disable an item in the list via the yellow check box at the left of each row.

To edit the details for a symbol server, just double click the entry in the list to show the symbol server
dialog again.

Symbol server dialog

The dialog initially appears pre-populated with some default values and allows you to set up or edit the
definition of a symbol server. Some of the default values can be changed.

http://127.0.0.42:8000
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· Enable Symbol Server  enable or disable this server

The following three entries must be set to enable the OK button and define the symbol server.

 OK button not enabled?The OK button will only be enabled when the following entries have a
valid value:     - Symbol Server DLL names a dll present in the Memory Validator install directory.   -
Symbol Store Directory has been specified and exists.   - Symbol Server URL has been specified
(this value will not be checked for correctness).  

· Symbol Server  select a predefined public symbol server or enter the URL of the symbol server
you wish to use - the Microsoft server is initially set as the default 

· Symbol Store Directory  enter or Browse to set the directory that will contain local copies of the
downloaded symbols

The Symbol Server DLL is set automatically.

Reset - Resets all global settings, not just those on the current page. This includes removing any

symbol servers added.

5.1.2 Symbol Paths

The Symbols settings allow you to specify where Page Fault Monitor looks for symbols.



Page Fault Monitor22

Copyright © 2015-2026 Software Verify Limited

Manually adding path type directories

The Path list shows all the paths that will be searched for debug information in PDB files.

You can modify the list of files for each path type in the following ways:

· Add  appends a row to the directory list  enter the directory path 

Edit a directory path by double clicking the entry. The usual controls apply for removing list items:

· Remove  removes selected items from the list 

· Remove All  clears the list 

· Set Default  adds all valid directories found in the _NT_SYMBOL_PATH environment variable, plus
the Windows symbols directory 

Alternatively, press  to delete selected items, and  +  to select all items in the list first.

Reset - Resets all global settings, not just those on the current page. This includes removing any

symbol servers added.
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5.2 Misc

5.2.1 Source Paths

The Source Paths settings allow you to specify where Page Fault Monitor looks for source code files.

The source code paths are used when a filename is incomplete - a filename without a path, a filename
with a partial path, or a filename that isn't valid on this machine.

Manually adding path type directories

The Path list shows all the paths that will be searched for source code files.

You can modify the list of files for each path type in the following ways:

· Add  appends a row to the directory list  enter the directory path 

Edit a directory path by double clicking the entry. The usual controls apply for removing list items:

· Remove  removes selected items from the list 

· Remove All  clears the list 

· Set Default  adds all valid directories found in the PATH environment variable 

Alternatively, press  to delete selected items, and  +  to select all items in the list first.
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Reset - Resets all global settings, not just those on the current page. This includes removing any

symbol servers added.
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6 Starting your target program

Enter topic text here.

6.1 Launching the program

To start your program choose Start Application... on the Launch menu,

Keyboard shortcuts:

  

The launch program dialog will be displayed.

The picture shows some already launched programs shown in the scrollable list. You can relaunch these
programs by double clicking their entry in the list.  Depending on what you want to do with your program
you have a choice of launching the program.

Detailed program start (1)
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1) Type in the program name in the Application field, or click the Browse... button to   use a file
browser to choose the program to launch.
2) Type in the program arguments in the Arguments field. 
3) Type in the program directory in the Startup Directory field, or click the Browse... button to use a
directory browser to choose the directory.
4) Click on the Launch button to launch the program.

Page Fault Monitor will start the program and monitor the program for page faults.

Detailed program start (2)

1) Click on the program shown in the scrolled list that you want to start. The details for the program will
appear in the Application, Arguments and Startup Directory fields.
2) Modify any of the Application, Arguments and Startup Directory fields as appropriate. 
3) Click on the Launch button to launch the program.

Page Fault Monitor will start the program and monitor the program for page faults.

Repeat program start

Double click on the program shown in the scrolled list. The program will be launched automatically.

Page Fault Monitor will start the program and monitor the program for page faults.

If at any point you would like the fields reset, click on the Reset button.

6.2 Re-Launching the program

To re-start your program choose Re-Start Application... on the Launch menu,

Keyboard shortcuts:

  

The application that was most recently launched is started.



Page Fault Monitor28

Copyright © 2015-2026 Software Verify Limited

6.3 Monitoring a process

To monitor an already running program for page faults choose Monitor a Process... on the Launch
menu,

Keyboard shortcuts:

  

The inject program dialog will be displayed.

· System processes / Services / User processes   show either of system or services or user
processes in the list, or both  

· Full path  shows the full path to the process executable in the list 

· Image Name  shows the short program name without path 
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· Refresh  update the list with currently running processes 

· Attach  start monitoring page faults in the selected process 

Administrator Mode

It is not possible to monitor some applications for page faults unless Page Fault Monitor is running in
Administrator Mode.

Applications needing Administrator Mode to be monitored as denoted by a shield icon displayed in the
Admin column of the grid.

If you try to monitor an application needing Administrator Mode you will be prompted to relaunch Page
Fault Monitor in Administrator Mode.

6.4 Waiting for a program

To monitor a program that hasn't started yet choose Wait For Application... on the Launch menu,

Keyboard shortcuts:

  

The Wait for process dialog allows you to specify a process that when it starts, Page Fault Monitor will
attach to and start collecting debug events.
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· Application Path Policy  specify if the application you're going to wait for exists on a specific
path or it's going to be created dynamically (and the path will therefore be unknown) 

· Application Executable  type or Browse to set the application name to wait for 

· Full path  shows the full path to the process executable in the list 

· Image Name  shows the short program name without path

· Reset  clears the list

· Wait for Process  start waiting for the process to start. When the process starts Page Fault
Monitor will attach to it and start collecting debug events.

· Stop Waiting  stops waiting for the process to start
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7 Viewing the list of DLLs

The Process DLLs dialog allows you to view the list of DLLs in the process being monitored.

The display consists of a list of DLL information, with information for each DLL displayed on one line.

The information displayed is DLL name, load address, DLL size and the full path to the DLL.

The display can be sorted by each column. Click the column header to choose which column to sort the
data. Click the same column again to reverse the sort direction.
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8 How to use Page Fault Monitor

Select a process to monitor

Use the File > Monitor a Process... option to choose a process to monitor

The grid displays page fault data as page faults are detected.

Page fault addresses are converted to symbols according to the settings.

Select a symbol to see information about the line numbers and source code and pages that were faulted
at this address.

Please note that if you have symbol servers enabled there may be a delay in providing symbol
information the first symbols for a specific DLL are downloaded from the symbol server.
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